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1Welcome to 
PREMIER+™ 2 Thread Cache

Use PREMIER+™ 2 Thread Cache to list your personal thread 
collection, to create a list of favorite thread ranges, and to view your 
threads on your phone or tablet.

Use PREMIER+™ 2 Thread Cache  to list your personal thread collection in one 
or more My Threads palettes and print a My Threads shade card. Create your own 
list of favorite thread ranges, too. Use My Threads palettes and My Thread Ranges 
to choose from only the threads you own when changing or adding colors in the 
PREMIER+™ 2 Embroidery System.

Finding Information

Reference Guide
The Reference Guide shows how to start the app and provide a quick tour of the 
main screen. It also contains full reference information. The Reference Guide is 
supplied in PDF format , ready for printing, and contains full reference 
information.

Help
The integrated help contains full reference information. Click the Help button . 
Where available, a help topic appears that is relevant to the selected item. 
Alternatively, use the Help menu.

Viewing and Printing PDF Guides
To find all the Reference and Sample Guides for your PREMIER+™ 2 Embroidery 
System, go to Home/Premier+2/Guides, then double-click Reference Guides or 
Sample Guides. Select the desired PDF guide.

Note; To view and print the PDF Guides, you may use Preview which is included in 
your Mac OS®.

Readme
The most up-to-date details about the PREMIER+™ 2 Embroidery System are in 
the Readme.rtf file available when you install your PREMIER+™ 2 Embroidery 
System.

Internet FAQs
The FAQ option on the Help menu connects to an internet database of frequently 
asked questions about the PREMIER+™ 2 Embroidery System. Search topics 
relating to the app you are using, or search all topics.
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Tutorials
Interactive training exercises are available for many of the apps. They provide a 
'show-me' experience that will help you learn how to use key features of the 
software. The tutorials are found in the online Learning Center on the Internet. 
Use the Help menu, or browse to EmbroideryLearningCenter.com.

Sample Files
Samples are included for your use. The sample files are installed to subfolders of 
Home/Premier+2/Samples/ or the folder of your choice.

Further Information
For general information on installing the PREMIER+™ 2 Embroidery System, refer 
to the PREMIER+™ 2 Embroidery System Getting Started Guide.

About PREMIER+™ 2 Thread Cache
Access via the PREMIER+™ 2 Thread Cache menu. The version number of 
PREMIER+™ 2 Thread Cache is given here. You will need this if you contact 
technical support at any time.

Starting PREMIER+™ 2 Thread Cache

� Click the PREMIER+™ 2 Thread Cache icon  in the Launchpad.
� Double-click the PREMIER+™ 2 Thread Cache icon  in the Finder.

Minimize and Maximize
� Use the yellow minimize button  at the top left to minimize the current window.
� Use the green zoom button  at the top left to switch between a larger and 

smaller window size.

Quit PREMIER+™ 2 Thread Cache
� Choose PREMIER+™ 2 Thread Cache > Quit PREMIER+™ 2 Thread Cache.
� Use the red close button  at the top left. 
� Press ⌘Q
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2Using PREMIER+™ 2 Thread 
Cache

Use PREMIER+™ 2 Thread Cache to organize your thread ranges as 
My Thread Ranges  and create personal My Thread databases. Print 
or upload a thread list for use on the move.

Use PREMIER+™ 2 Thread Cache to organize your preferred thread ranges in a 
list called My Thread Ranges and your personal thread collection in one or more 
My Thread palettes. Use the buttons (tabs) at the top of the PREMIER+™ 2 
Thread Cache screen to change the view between My Thread Ranges, My Thread 
Databases and My Thread Stock. 

Print a list from your My Thread databases, or upload your My Thread databases to 
the Thread Cache website. Note your thread purchases as you visit different 
stores.

Overview
� Use My Thread Ranges to create a group of favorite personal and manufacturer 

thread ranges for use when selecting thread colors.
� Use My Thread Databases to create a My Thread database of the manufacturer and 

personally created threads that you own. Select threads from this range when 
designing embroideries.

� Use My Thread Stock to record how many spools you have for each thread in the 
selected My Thread database, and to highlight and annotate threads for which you 

To learn how to Go to

Create and modify a list of favorite thread 
ranges.

See “My Thread Ranges” on page 10.

Choose the threads from many different 
manufacturers and list them together in a My 
Thread database.

See “My Thread Databases” on page 13.

Note the quantity of each thread in the 
selected thread database, and print a list or 
upload to the Thread Cache website to view 
on your mobile device.

See “My Thread Stock” on page 30.

Use Thread Cache on your mobile device to 
review your threads when on the move, and to 
note your thread purchases.

See “The Thread Cache Website” on 
page 39.

Create a thread database in PREMIER+™ 2 
Thread Cache and upload it to the Thread 
Cache website for use on your mobile device.

See “Create a My Thread Database and 
Upload it to your iOS Device” on page 6.
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need extra spools. Print a list, or upload the database to the Thread Cache website 
to view on your mobile device.

� Use Thread Cache on your mobile device to view your threads, and note the 
threads as you purchase them.

My Thread Ranges
Use the My Thread Ranges window of PREMIER+™ 2 Thread Cache to create and 
modify your list of favorite thread ranges. My Thread Ranges is used in the Color 
Selection dialog to make it easier to select your favorite thread ranges.

The standard thread ranges are grouped by manufacturer. 

Move thread ranges up and down your list of My Thread Ranges, and Delete 
unwanted thread ranges.

Choose a manufacturer 

Add the selected thread
range to My Thread Ranges

Change the order of thread
ranges in My Thread Ranges

Remove a thread range from 
My Thread Ranges

Choose a manufacturer from 

Select a range in 

the list

thread range

My Thread Ranges
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My Thread Databases
Choose the threads you own from many different manufacturers and list them 
together in a My Thread database.

Note: The abbreviation for the Thread Range is automatically added before the 
number in a My Thread database; for example SuMS3 for Sulky Metallic Sliver 30 
weight. If the whole of a My Thread database that you create is from one new 
manufacturer, create an appropriate database name and the abbreviation will be 
added automatically.

You may create new custom threads, or copy and modify existing threads. Select 
threads in the standard thread ranges by color using the Colors window. 
Alternatively, use Import Threads from Embroidery to add custom colors and 
databases from a friendfriend, or Export Threads to Embroidery to give threads 
definitions to a friend, or backup your My Thread database.

Note: When threads are added to a My Thread database, they are shown in the 
Color Selection dialog the next time it is used in any PREMIER+™ 2 Embroidery 
System app. Add Color Effects to selected threads within a design using the Color 
Selection dialog of PREMIER+™ 2 Embroidery System modules, not in 
PREMIER+™ 2 Thread Cache.

Updating the Standard Thread Database
If your friends give you .vp4 format embroideries they have created, the 
embroideries may contain thread definitions from a later version of the standard 
thread database. In order to have these colors available, the updated Standard 
Thread Database must be downloaded and installed.

Select a thread range

Select a thread by number or color
Add the thread to the selected My Thread database

Add or remove a database 

Choose a My Thread database
Rename the selected database

Search for a thread in 
the current database

View the selected thread

Create or remove a thread

Move the thread up or down
Edit or copy the thread

Import/export thread definitions
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Use Smart Update to check for the latest Standard Thread Database. See the 
PREMIER+™ 2 Configure Reference Guide.

My Thread Stock
Use the My Thread Stock window of PREMIER+™ 2 Thread Cache to note the 
quantity that you have of each thread in the selected My Thread Database, and to 
print the list or upload it to the cloud, ready to view on the Thread Cache website 
on your mobile device.

Create a My Thread Database and Upload it to your iOS Device
1 In PREMIER+™ 2 Thread Cache, click the My Thread Databases button.
2 In the My Thread Databases section, click Add 

New Database .
3 In the Thread Database Name dialog, enter a 

name for the new thread database.
A name is suggested (such as "My Threads 1") 
but you can enter any name you choose.

4 Click OK to create the new database.
5 Click the My Thread Ranges button.
6 Click your new My Thread database to highlight it.
7 Click the Add To My Thread Ranges arrow  button. My Threads 1 is added to the end of 

the My Thread Ranges list.
Note: Your new thread database will now be listed when you select My Thread Ranges in the 
Color Selection dialog.

8 Click the My Thread Databases button.
9 In Thread Range, select My Thread Ranges.
10 In the pop-up menu, choose a manufacturer’s thread range, for example Sulky Rayon 40,  

from the list. The list of threads changes according to the chosen range.

Select a My Thread database

Print the selected database
Upload the selected database

Click to select a thread
Control–click to edit Spools
and Notes

Sort by the column headings

Edit Spools and Notes for the selected threads
Click to highlight a thread with a star

Return to the original order
Change the number of spools
for the selected threads
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11 Click in the Number box and enter 1023.
As the number is entered, the thread appears..

12 Click the color block to select it, and its details are shown, 1023 (Yellow).
13 Then click the Add To My Threads arrow  button. The thread SuRa5-1023 is added to 

the My Threads 1 database in the pane on the right.
14 Delete all text in the Numbers box, and the full list of colors reappears.
15 Click Select by Color .
16 Click Colored Pencils  to select the Colored Pencils color model.
17 Click the green, number 5 in the second row. Thread 1277 (Ivy Green) is selected.
18 Click Add To My Threads  to add it to your list of colors.

Use the Colors window to select the nearest shade to the color you choose that is available 
from the current thread range.

19 Use the Colored Pencils to add a blue and a red to your list of threads, then close the 
Colors window.

20 Below your new list of threads, click the Add New Thread  button. The Thread dialog 
appears. For more information, see “Add a New Thread to a My Thread Database” on 
page 17.

21 Enter a Thread Number, for example 4000.
22 Enter a Thread Name, for example MyBlueThread.

Note: The Thread Number can be up to 13 characters, 
including letters. The name can be up to 29 characters.

23 Choose the Thread Type from the pop-up menu.
24 Choose the Thread Weight from the pop-up menu.
25 Click the color block in Single Color, and use the Colors 

window to select a blue color for the thread.
26 Click OK to create the thread.
27 Click Move Up . The blue that you just created moves one 

place up the thread list.
Note: Use Move Down  to move a color down the list, and 
Delete  to remove a color from the list. Use Edit  to 
change a thread, and Copy Thread  to copy an existing thread to use as the basis for a 
new thread.

28 Click the My Thread Stock button.
29 In the My Thread Database pop-up menu, ensure that My Threads 1 is selected.
30 Click the Name column heading. The database is sorted by name.

Note: You can sort by any of the headings.
31 Click the Reset Sort Order button. The list returns to its original order.
32 Highlight the blue thread that you created, and then click the Notes field for that thread to 

open it for editing.
33 Enter the text "3 spools needed" and press Return. The note is added to the blue thread.
34 Highlight the yellow thread and click the Quick Spool Count +1  button. There is now 

one spool of the yellow thread.
35 Command–click to select the green and red threads. Both are highlighted.
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36 With the threads still selected, click the Edit 
Selected button. The Edit Selected dialog 
opens.

37 Select (check) the "Set number of spools to all 
selected" checkbox.

38 Set the number of spools to 3.
39 Select (check) the "Set notes to all selected" 

checkbox.
40 Enter the text "1 spool needed" in the Notes 

text box.
41 Click OK. Both threads are now listed as having 

3 spools, and needing an extra spool.
Note: Use the Edit Selected dialog to change the spool number, size, and the notes for 
several threads at the same time.

42 Click in the Star  column for the first of your selected threads. The thread is highlighted 
with a star.

43 Add a star to the other two threads with notes.
44 Click the column header star to sort by this column. All of the highlighted threads are now 

listed together. This is a good way to review your highlighted threads. For more information, 
see “Viewing and Sorting Threads in a My Thread Database” on page 31.

45 Click the Upload button . The Cloud Connection dialog appears.
46 Enter the e-mail address for your Software Registration Database account in the text box.
47 Enter the password for your Software Registration Database account in the Password text 

box.
48 Select (check) the Remember Password checkbox to save your password for the next time 

you sign in.
Note: Do not select this option if you are using a shared computer.

49 Click OK to upload the My Threads 1 database to the Software Registration Database.
50 Open the PREMIER+™ 2 Thread Cache website on your mobile device:

ThreadCache.PremierPlusEmbroidery.com
Note: On a tablet a wide screen showing both the Thread and Details panes will be 
displayed.

51 Tap the Download Threads button . The Cloud Connection Settings window is displayed.
52 Enter the e-mail address and password for your Software Registration Database account, or 

sign in using your Facebook® , Twitter®  or Google+®  social media account.
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53 Tap View My Thread Databases. Your thread databases 
are downloaded.

54 In the main window, select your personal thread database 
(here My Threads 1) from the My Threads pop-up menu.

55 Tap one of the threads to see its details.
56 In the Thread pane, tap Purchased to set the thread to 

Purchased.
57 Tap Back to go back to the My Threads window. The 

thread is now marked with a P.
58 In the My Threads pop-up menu, select Star Threads. 

Only your star threads are displayed.
For more information, see “The Thread Cache Website” 
on page 39.

59 When you are back at your computer, update the thread 
spool information in your My Thread databases in 
PREMIER+™ 2 Thread Cache.

Backup and Restore
Use Backup My Settings  and Restore My Settings  to backup and restore 
your My Thread databases and your My Thread Ranges. Backup My Settings and 
Restore My Settings are on the Utilities window of PREMIER+™ 2 Configure.

It is recommended to use Backup My Settings  after making significant changes 
to your My Thread databases and your My Thread Ranges.
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3My Thread Ranges

Use the My Thread Ranges window of PREMIER+™ 2 Thread Cache 
to create and modify a list of favorite thread ranges.

Use the My Thread Ranges window of PREMIER+™ 2 Thread Cache to create and 
modify your list of favorite thread ranges. My Thread Ranges is used in the Color 
Selection dialog to make it easier to select your favorite thread ranges.

The standard thread ranges are grouped by manufacturer. 

To open the My Thread Ranges window
� In PREMIER+™ 2 Thread Cache, click the My Thread Ranges button.
� Choose View > My Thread Ranges
� Press ⌘1

Move thread ranges up and down your list of My Thread Ranges, and Delete 
unwanted thread ranges.

To learn how to Go to

Add Ranges to My Thread Ranges See “Add a Thread Range to My Thread 
Ranges” on page 11.

Change the order of the thread ranges See “Change the Order of My Thread Ranges” 
on page 11.

Remove a range from My Thread Ranges See “Delete a Thread Range from My Thread 
Ranges” on page 11.

Choose a manufacturer 

Add the selected thread
range to My Thread Ranges

Change the order of thread
ranges in My Thread Ranges

Remove a thread range from 
My Thread Ranges

Choose a manufacturer from 

Select a range in 

the list

thread range

My Thread Ranges
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Select a Thread Range
� Choose a manufacturer or My Thread Databases from the Manufacturer pop-up 

menu, then click the desired thread range in the list. 

Organize My Thread Ranges
Use the My Thread Ranges window of PREMIER+™ 2 Thread Cache to create and 
modify your list of favorite thread ranges. My Thread Ranges is used in the Color 
Selection dialog to make it easier to select your favorite thread ranges.

Add a Thread Range to My Thread Ranges
Add a Standard (Manufacturer) or My Threads (personal) thread range to My 
Thread Ranges.

Add a Thread Range
1 Choose the Manufacturer from the pop-up menu. 
2 Click the desired thread range in the list to highlight it. 

Note: To select multiple thread ranges, use Shift–click to select a consecutive sequence of 
thread ranges, or Command–click to select thread ranges individually.

3 Click the Add To My Thread Ranges arrow  button. The selected thread range(s) are 
added to the end of the My Thread Ranges list.

Change the Order of My Thread Ranges
The thread ranges can be listed in My Thread Ranges in any order. Move the thread 
ranges within the list.

Moving a Thread Range in My Thread Ranges
� Click the desired thread range in the list, then click the Move Up  or Move 

Down  button below the list.
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Delete a Thread Range from My Thread Ranges
Thread ranges can be deleted from My Thread Ranges. Only one thread range can 
be deleted at a time.

Note: It is possible to delete My Thread databases from My Thread Ranges. They 
will always be visible at the top of the All Thread Ranges list in the Color Selection 
dialog.

� Click the desired thread range in the My Thread Ranges list, then click the 
Delete  button below the list. The thread range is removed from the list. 

Note: There is no confirmation message for deleting thread ranges from My Thread 
Ranges.
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4My Thread Databases

Choose the threads you own from many different manufacturers and 
list them together in a My Thread database. Create a new My Thread 
database.

Use the My Thread Databases window to choose the threads you own from many 
different manufacturers and list them together in a My Thread database. Create 
your own thread database, and add the threads you own to it.

Note: The abbreviation for the Thread Range is automatically added before the 
number in a My Thread database; for example SuMS3 for Sulky Metallic Sliver 30 
weight.

To open the My Thread Databases window
� In PREMIER+™ 2 Thread Cache, click the My Thread Databases button.
� Choose View > My Thread Databases
� Press ⌘2

You may create new custom threads, copy and modify existing threads, or import 
threads from an embroidery. Select threads in the standard thread ranges by color 
in the Colors window.

If the whole My Thread database is from one new manufacturer, create an 
appropriate database name and the abbreviation will be added automatically.

Note: A sample thread database, My Threads, is available when PREMIER+™ 2 
Thread Cache is installed.

Select a thread range

Select a thread by number or color
Add the thread to the selected My Thread database

Add or remove a database 

Choose a My Thread database
Rename the selected database

Search for a thread in 
the current database

View the selected thread

Create or remove a thread

Move the thread up or down
Edit or copy the thread

Import/export thread definitions



14          PREMIER+™ 2 Thread Cache   My Thread Databases 

Note: When threads are added to a My Thread database, they are shown in the 
Color Selection dialog the next time it is used in any PREMIER+™ 2 Embroidery 
System app. Add Color Effects to selected threads within a design using the Color 
Selection dialog of PREMIER+™ 2 Embroidery System modules, not in 
PREMIER+™ 2 Thread Cache.

Updating the Standard Thread Database
If your friends give you .vp3 or .vp4 format embroideries they have created, the 
embroideries may contain thread definitions from a later version of the standard 
thread database. In order to have these colors available, the updated Standard 
Thread Database must be downloaded and installed.

Use Smart Update to check for the latest Standard Thread Database. See the 
PREMIER+™ 2 Configure Reference Guide.

Note: Alternatively, the embroideries may contain custom thread definitions from 
their My Threads databases. See “Import Threads From Embroidery” on page 26.

Note: A thread definition gives the name, number, thread type and weight, and the 
color for the thread (or colors for a variegated thread).

Find Threads
Find Threads in the Standard Thread Database Pane

1 Click the pop-up menu in the Thread Range section and choose the desired manufacturer’s 
thread range. The list of threads changes according to the selected range.
Alternatively, enter the manufacturer name in the Filter box to reduce the list of thread 
ranges to those from the desired manufacturer, then select a thread range.

2 Click in the Number box.
3 Enter the desired thread number from the manufacturer’s range. As the number is typed, 

the first matching thread is highlighted and its details are shown.

To learn how to Go to

Find a thread in a thread database See “Find Threads” on page 15.

Add manufacturer threads to a My Thread 
database

See “Add Standard Threads to a My Thread 
Database” on page 15.

Create a new My Thread database See “Add a New My Thread Database” on 
page 25.

Create a new thread for a My Thread 
database

See “Add a New Thread to a My Thread 
Database” on page 17.

Copy a thread to create a new thread See “Copy an Existing Thread in a My Thread 
Database” on page 22.

Arrange the threads in a My Thread 
database

See “Organize a My Thread Database” on 
page 23.

Choose a thread color See “Colors Window” on page 21.
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Alternatively, scroll down the list and select a thread.

Find Threads in the My Thread Databases Pane
1 Click in the Number box in the My Thread Databases pane.
2 Enter the desired thread number without the manufacturer’s abbreviation. The first 

matching thread appears and its details are shown.
Alternatively, type the full thread number including the manufacturer’s abbreviation. This is 
only necessary if you have threads with the same thread numbers from different 
manufacturers.

3 Click the color block to select it.

Add Standard Threads to a My Thread Database
Choose the threads you own from many different manufacturers and list them 
together in a My Thread database. The abbreviation for the Thread Range is 
automatically added before the number in the My Thread database; for example 
SuMS3 for Sulky Metallic Sliver 30 weight.

Note: It is not possible to add Inspira Cutwork or Felting Needles to a My Thread 
database.

Add Threads to a Database
1 In My Thread Databases, choose a personal thread database (for example, My Threads).
2 In Thread Range, select My Thread Ranges or All Thread Ranges.
3 In the pop-up menu, choose a manufacturer’s thread range or a personal My Thread range 

from the list. The list of threads changes according to the chosen range.
Note: The thread range abbreviation is a short code for the manufacturer, the thread type 
and/or range name and then a number representing the thread weight (see “Thread Weight” 
on page 19).

4 To add a single color, either type in its number in the Find Thread box, or scroll through the 
list and click it to select it.

Alternatively, click Select by Color  and use the Colors window to select a color. The 
nearest shade that is available from the current thread range is selected. This is also a quick 
way to jump to threads of a color (for example, click light yellow in the Colored Pencils to 
jump to light yellow thread shades).

5 To add a consecutive sequence of colors, select the first color. Then hold Shift and click the 
last color. All the colors in the sequence are highlighted. 

6 To add a selection of colors, select the first color. Then hold down Command and click 
other colors. 

7 Click the Add To My Threads arrow  button and the chosen thread(s) are added to the 
end of the My Thread database list.
Note: If an identical thread already exists in the thread database, the thread will not be 
added. If a thread from another My Thread database is added, a code representing the name 
of the database is prefixed to the name.
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Add a New Thread to a My Thread Database
You can add or customize your own thread information.

If you have threads that are not included in the Standard Thread Database, create a 
new My Thread Database with the name of the maufacturer, thread material and 
weight. When you add new thread to the My Thread Database, the abbreviation is 
added automatically.

Add a New Thread
1 Click the Add New button  and the Thread dialog appears.

Note: Use Copy Thread , then Edit , in a My Thread database to copy an existing thread 
to use as the basis for a new thread. See “Copy an Existing Thread in a My Thread 
Database” on page 22.

2 Enter the Thread Number. The number can be up to 13 characters long. It may include 
letters, for example to include an abbreviation for the name of the thread range.

Enter a thread number
Enter a thread name
Select a thread type
Select the thread weight
Create a single color thread

Select the colors for
a variegated thread

Create a variegated thread
Preview the thread color

Enter the RGB values

Add or remove a color
Move a color up or down

Make color changes smooth

for a thread
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Note: If the whole My Thread database is from one new manufacturer, create an appropriate 
database name and the abbreviation will be added automatically.

3 Enter the Thread Name, which is usually a description of the color. 
The name can be up to 29 characters long.

4 Choose the Thread Type from the pop-up menu.
5 Choose the Thread Weight from the pop-up menu.
6 Click the color block in Single Color to use the Colors window to select a color for your 

new thread.
See “Add a Variegated Thread” on page 18 to create a multicolor thread.

7 Click OK to create the thread.

Add a Variegated Thread
Use the Variegated Thread options for multicolor threads.

1 Create a new thread, selecting Variegated Colors instead of Single Color. The default color 
appears at the top of the list. See “Add a New Thread” on page 17.

2 If desired, check Smooth Blend so that the change 
from one color to the next is gradual.

3 Click the color block and select a color from the 
Colors window.

4 Click Add Color  to add a color to your 
variegated thread. Another color block appears.

5 Click the color block and change the color as 
desired.

6 Add a third color block and change it to the 
desired color.

7 All new colors in a thread are added with a length 
of 1mm. Select the number for a color and click 
the up and down arrows, or enter a number, to 
change the length of the color along the thread.

8 To change the position of a color in the list, select 
the color and click Move Up  or Move Down 

 to move the color up or down the list.
9 To remove a color from the variegated thread, select the number for the color, and click 

Delete .
10 Click OK to create the thread.

Thread Options

Thread Number
Enter the desired thread number up to 13 characters long. This should be a unique 
thread number in My Thread Databases.

Thread Name
Enter the desired thread name, which usually a description of the color. The thread 
name can be up to 29 characters long.
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Thread Type
Choose from the following thread types in the pop-up menu:

Thread Weight
Choose from the following thread weights in the pop-up menu:

Note: The number in brackets is used to indicate the thread weight in the 
abbreviation for the Thread Range.

Smooth Blend
Smooth Blend alters the way the colors in the threads change from one to the 
next. 

• If Smooth Blend is selected (checked), the colors are blended across the point 
where they meet, so that the change from one color to the next is smooth. 

• If Smooth Blend is not selected (unchecked), the color change is abrupt between 
one color and the next. 

Color List
The color list shows the colors that make up variegated threads, and the length of 
each color section in mm. For newly added threads, there will be one color in the 
list, set to red with a length of 1mm.

Note: Most threads are single-color threads, which are unaffected by this length 
setting. 

Color Blocks
Change the color for the selected color block in the Colors window (see page 20). 
Choose a color for your new thread, or set the first color if it is a variegated 
thread.

� Click a color block to choose a color for that block in the Colors window.

Variegated Thread
The Variegated Thread options are used for multicolor threads.

� Cotton
� Cotton Mercerized
� Fluorescent 
� Metallic
� Metallic Holographic
� Metallic Sliver

� Metallic Sparkle
� Polyester
� Rayon
� Silk
� Wool

� 12 (0)
� 18 (1)
� 25 (2)
� 30 (3)
� 35 (4)

� 40 (5)
� 50 (6)
� 60 (7)
� 80 (8)
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Add Color
Add a color to the variegated thread colors.

� Click Add Color , then click the color block to select the desired color in the 
Colors window (see page 20), and to select the color length.

Color Length
All new colors in a thread are added with a length of 1mm. If desired, change the 
length from the 1mm default. Enter a length in mm from 1mm to 1000mm.

� Select the number for a color and click the up and down arrows, or enter a 
number, to change the length of the color along the thread.

Note: Subsequent colors will initially be red (RGB 255, 0, 0), and will use the color 
length of the color above.

Delete
Delete a color from the variegated thread. There is no confirmation. If there is 
only one color, it will not be deleted.

� Select the number for a color in the list and then click Delete  to remove it.

Move Up and Move Down
Use Move Up  and Move Down  to move colors up and down the list of 
colors.

� Select the number for a color in the list and then click Move Up  to move it up 
the list of colors, and Move Down  to move it down the list of colors.

Preview
Preview your selected colors as an embroidery and as thread.

Quick RGB
Enter the RGB (Red, Green, Blue) values for the color in the Quick RGB number 
fields. See “Red, Green, Blue (RGB) Color Model” on page 21.

Color Models

Hue, Saturation, Luminance (HSL) Color Model
Hue is the color (red, yellow, green, or blue) for the selected color, expressed as a 
value between 0 and 239. Saturation (Sat) is the strength or purity of color in a 
specified hue. This is related to the amount of gray in it and is measured from 0 
(completely gray) up to a maximum of 240 (no gray). The higher the saturation, the 
purer or more vivid the color. Luminosity (Lum) is the intensity of lightness or 
darkness in a color, specified by a value between 0 (black) and 240 (white). If 
Saturation is 0, the Luminosity setting specifies a shade of gray.
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Red, Green, Blue (RGB) Color Model
The RGB model, one of the Additive Color models, is used on computer 
monitors. It has three primary colors — red, green, and blue — that it creates by 
emitting light. These three colors are combined in various proportions to produce 
all the colors displayed on your screen. They are referred to as additive because 
they combine to produce white. Primary colors are measured as a value from 0-
255. The colors produced by combining the three primaries are a result of the 
amount of each of those shades present. For example, pure red has a red value of 
255, a green value of 0, and a blue value of 0. Yellow has a red value of 255, a green 
value of 255, and a blue value of 0. If Red, Green and Blue are set to zero, the color 
is black; if all three are 255, they produce white.

Colors Window
Use the Colors window to choose a color for a thread. The nearest shade in the 
current thread range is selected.

Use the Colored Pencils to select a color quickly.

Note: Other color models show a greater variety of shades: Color Wheel, Color 
Sliders, Color Palettes and Image Palettes.

Select a color for a thread
1 Select a color, then click the color block in the Thread dialog. The Colors window opens.
2 Click Colored Pencils  to select the Colored Pencils color model.
3 Click one of the 48 pencils. The thread color changes in the Thread dialog.

The shade nearest to the pencil shade is used.
4 Close the Colors window when you have chosen a color.

Copy Thread
Use Copy Thread  to copy an existing thread in a My Thread database to use as 
the basis for a new thread definition.

Colored PencilsSelect a color model

Click to select a color

Drag the selected color 
to the palette



PREMIER+™ 2 Thread Cache   My Thread Databases              21

Note: When threads are added to a My Thread database, they are shown in the 
Color Selection dialog the next time it is used in any part of the PREMIER+™ 2 
Embroidery System.

Copy an Existing Thread in a My Thread Database
1 Select a thread database in My Thread Databases.
2 Highlight a thread in the selected My Thread database list.
3 Click Copy Thread  to make a duplicate of that thread at the end of the list. 

The new thread has an underline and a number placed at the end of its Thread Number to 
make it unique in the My Threads list. It is highlighted so you can Edit the thread.

Organize a My Thread Database
You can edit threads in a My Thread database, delete threads and change the order 
of the threads.

Note: Changes to a My Thread database are shown in the Color Selection dialog 
the next time it is used in any part of the PREMIER+™ 2 Embroidery System.

Change the Order of a My Thread Database
Threads added to a My Thread database are added at the end of the list. They can 
be moved up and down the list, so that they are listed in the order you desire.

Note: If you do not change the order of the My Thread database the list will show 
the order in which the threads were added.

1 Click the thread that you want to move in the My Thread database. It is highlighted.
2 Click the Move Up  and Move Down  buttons to move the thread to the desired 

position. It remains highlighted while it is moved.
3 Repeat until the My Thread database is sorted as desired.
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Delete a Thread
Threads may only be deleted from a My Thread database, not from a Standard 
Thread Database. When deleting, a message appears saying that deleting a thread is 
permanent and may not be undone.

Note: Deleting from a My Thread database has no effect on the threads in the 
Standard Thread Database.

� Click a thread to highlight it, and then click the Delete  button. Click Yes to 
delete the thread.

Edit a Thread
Edit the details for a thread in the Thread dialog. See “Thread Options” on 
page 19.

To open the Thread dialog
� Click a thread in the My Thread database list, then click Edit . The thread dilaog 

opens.
� Double-click the desired thread in the My Thread database list. The Thread dialog 

opens.

Add a New My Thread Database
Create a customized My Thread database for your threads.

Create a Personal My Thread Database
1 In the My Thread Databases section, click Add 

New Database .
2 In the Thread Database Name dialog, enter a 

name for the new thread database.
A name is suggested (such as "My Threads 1") 
but you can enter any name you choose.
Note: If the whole My Thread database is from one new manufacturer, create an appropriate 
database name and the abbreviation will be added automatically.

3 Click OK to create the new database.
4 Add threads to the My Thread database as described above. 

To rename your My Thread database, click Rename Database  and enter a new name in 
the Thread Database Name dialog.

To delete a My Thread database, click Delete Database  and click Yes to confirm.
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Thread Database Name
Use the Thread Database Name dialog to name and rename your My Thread 
databases.

� In the My Thread Databases section, click Add New Database  and in the Thread 
Database Name dialog enter a name for the database. Click OK to save the 
database name.

Delete My Thread Database
You can delete a My Thread database in the My Thread Databases 
section. A warning message is displayed before the thread range is 
deleted, saying that deleting a thread is permanent and may not be 
reversed.

� In the My Thread Databases section, click Delete Database , and click Yes to 
confirm.

Rename My Thread Database
You can rename a My Thread database in the Thread Database Name dialog.

� Click Rename Database  to rename the selected My Thread database. The 
Thread Database Name dialog opens.

Import Threads From Embroidery
Use Import Threads From Embroidery  to import custom threads from an 
embroidery given to you by a friend.

If another user gives you any .vp4 or .vp3 format embroideries they have created, 
the embroideries may contain custom thread definitions from their My Threads 
databases that you do not have in your own My Threads databases. You can use the 
Import Threads From Embroidery function to add another user’s thread definitions 
to your My Threads databases.

Note: This is also useful if you delete one of your own custom thread definitions 
and then wish to recover it from an embroidery that used it.
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Import Threads from an Embroidery
1 Click Import Threads From 

Embroidery  and an Open dialog 
appears where you can select the desired 
.vp4 or .vp3 embroidery file.

2 Browse to and select the desired .vp4 or 
.vp3 format embroidery file, and then click 
Open to import any custom thread 
definitions that do not appear in your My 
Threads database.

3 If a thread in the embroidery uses the same 
number and thread database name as one of your threads, you will be asked if you want to 
overwrite it.
Note: This message will appear if you import one of your 
own custom threads, as well as if a completely different 
thread is imported.
A thread definition gives the name, number, thread type 
and weight, and the color for the thread (or colors for a 
variegated thread).

4 Select Yes, or Yes to All to overwrite your existing thread definitions, or No, or No to All 
keep your existing thread definitions.

5 When all of the threads have been imported, a message is displayed saying how many 
threads were added. Click OK to finish.
The threads are added to the end of your My Threads list.

Importing Threads from Other File Types
You cannot add custom thread definitions from any other embroidery file type, 
because the .vp4 and .vp3 formats are the only embroidery file formats that can 
contain the full thread information used by the PREMIER+™ 2 Embroidery System.

You cannot import thread definitions directly from PREMIER+™ 2 Create (.edo) 
or PREMIER+™ 2 Cross Stitcher (.krz) design files. To import custom thread 
definitions from one of these file types, create a Husqvarna Viking/Pfaff .vp4 
embroidery file from the unmodified design in PREMIER+™ 2 Create or 
PREMIER+™ 2 Cross Stitcher, and then import the custom thread definitions from 
the embroidery.

Note: Use Smart Update to update thread definitions in the Standard Thread 
Database. You cannot import new standard thread definitions with Import Threads 
from Embroidery.

Export Threads to Embroidery
Use Export Threads to Embroidery  to create a .vp4 embroidery from the 
selected My Threads database to act as a backup, or to give to another user.

Export Threads to Embroidery saves all the thread definitions in the selected My 
Threads database as a .vp4 embroidery using the thread database name, with a 
block for each thread color.
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Note: When imported using Import Threads From Embroidery , the threads 
from the embroidery are imported into a My Threads database with the same 
name as the original database.

• If a database of that name is already present (for example, My Threads 1), any 
new threads are imported into that thread database.

• If no database of that name is present, a new database is created.

Export Threads to an Embroidery
1 In the My Threads Databases window, select the desired My Threads database.
2 Click Export Threads to Embroidery . A Save As dialog appears for you to save the .vp4 

embroidery file.
Note: By default, the embroidery file uses the name of the My Threads database.

3 Save the embroidery file.
Note: Each color in the thread database is saved as a block of color in the My Threads 
database embroidery.

4 Place the embroidery file among your backups, or give it to a friend to add the threads to 
their thread databases.

5 To view the threads in the embroidery, open it in PREMIER+™ 2 Embroidery.

Note: Each color in the thread database is saved as a block of color in the My Threads 
database embroidery, with the name of the My Threads database set as the thread range.

6 To add the threads in the embroidery to your thread databases use Import Threads From 
Embroidery .
The threads are imported into a My Threads database using the same name as the original 
database.
Note: If a thread is already present, it will not be imported.
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5My Thread Stock

Use My Thread Stock to review your stock of threads, and to print a 
list, or upload it to the Thread Cache website to view on your 
mobile device.

Use the My Thread Stock window of PREMIER+™ 2 Thread Cache to sort the 
threads in any order, and note the quantity that you have of each thread in the 
selected My Thread Database. Print a My Threads shade card, or upload the thread 
list to the Thread Cache website to view on your mobile device.

To open the My Thread Stock window
� In PREMIER+™ 2 Thread Cache, click the My Thread Stock button.
� Choose View > My Thread Stock
� Press ⌘3

My Thread Stock
Use the My Thread Stock window of PREMIER+™ 2 Thread Cache to note the 
quantity that you have of each thread in the selected My Thread Database, and to 
print the list or upload it to the Thread Cache website, ready to view on your 
mobile device.

View the thread stock in a My Thread database
� In PREMIER+™ 2 Thread Cache click the My Thread Stock button, then choose a 

personal thread database in the My Thread Database pop-up menu.

Select a My Thread database

Print the selected database
Upload the selected database

Click to select a thread
Control–click to edit Spools
and Notes

Sort by the column headings

Edit Spools and Notes for the selected threads
Click to highlight a thread with a star

Return to the original order
Change the number of spools
for the selected threads
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.

Viewing and Sorting Threads in a My Thread Database
1 In PREMIER+™ 2 Thread Cache click the My Thread Stock button.
2 Choose the desired My Thread database in the My Thread Database pop-up menu.
3 Click the Name column heading. The database is sorted by name.

You can sort by name, thread number, thread type, thread weight, number of spools, spool 
size and notes. You can also sort by Star threads (those you have highlighted).

4 Click the Reset Sort Order button. The list returns to its original order.
Note: This is the sort order that you set in the My Thread Databases window. See “Change 
the Order of a My Thread Database” on page 23.

5 Highlight a thread, and then click the Notes field for that thread to open it for editing.
Alternatively, double-click to open the Notes field.

6 Enter the text "5 spools needed" and press Return. The note is added to that thread.
7 Highlight a thread, and then click the Spools field for the thread.
8 Increase the number of spools for that thread by one and press Return. The spool number 

has changed.
Note: You can edit the Notes and the number of spools for threads individually.

9 Click the Quick Spool Count -1  button. The number of spools decreases by one.
The Quick Spool Count buttons are an alternative way to change the spool count.

10 Command–click to select three threads. All three are highlighted.
11 Click the Quick Spool Count +1  button. 

The number of spools increases by one for all 
three threads.
This is a quick way of changing the number of 
spools for several threads.

12 With the three threads still selected, click the 
Edit Selected button. The Edit Selected dialog 
opens.

13 Select (check) the "Set number of spools to all 
selected" checkbox.

14 Set the number of spools to 3, then click OK. 
All three threads are now listed as having 3 spools.

To learn how to Go to

Sort the threads in a My Thread database See “Viewing and Sorting Threads in a My 
Thread Database” on page 31.

Change the number of thread spools and 
their size in a My Thread database

See “Viewing and Sorting Threads in a My 
Thread Database” on page 31.

Add notes to your threads See “Viewing and Sorting Threads in a My 
Thread Database” on page 31.

Edit the notes and spool size for several 
threads at one time

See “Edit Selected” on page 33.

Upload your My Thread database to the 
Thread Cache website, ready to view on 
your mobile device

See “Upload a My Thread Database to the 
Cloud” on page 37.
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15 With the three threads still selected, click the Edit Selected button again.
16 Select (check) the "Set spool size to all selected" checkbox.
17 Choose a different spool size from the pop-up menu.

Note: You can also use yards instead of meters as the measurement unit.
18 Select (check) the "Set notes to all selected" checkbox.
19 Enter the text "3 spools needed" in the Notes text box.
20 Click OK to close the dialog. The three selected threads now use a different spool size, and 

show the 3 spools note.
21 Click in the Star  column for the first of your selected threads. The thread is highlighted 

with a star.
22 Add a star to the other two edited threads.
23 Click the column header star to sort by this column. All of the highlighted threads are now 

listed together.
Note: This is a good way to review your highlighted threads.

24 Click the Reset Sort Order button. The list returns to its original order.

Thread Stock Information
View and edit the information for the threads in a My Thread database.

Star
Use a star to highlight a thread in the database, for example to order more spools.

� Click in the Star  column for a thread. The thread is highlighted with a star.

Color
The color block for the thread.

Number
The thread number, with the abbreviation for the thread range.

Name
The manufacturer or personal thread name.

Type
The thread type. See “Thread Type” on page 19.

Weight
The thread weight. See “Thread Weight” on page 19.

Spools
The number of spools you have of the thread.

� Click the spool field and enter the number of spools you have of that thread.
� Click the Quick Spool Count buttons to add  a spool or remove  a spool.
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� Select several threads and click the Edit Selected button to change the number in 
the Edit Selected dialog. See “Edit Selected” on page 33.

Size
The length of thread on each spool.

� Select one or more threads and click the Edit Selected button to change the spool 
size for the thread(s) in the Edit Selected dialog. See “Edit Selected” on page 33.

Notes
Notes about the thread, for example the number of spools needed.

� Click the Notes field and add a note for the thread.
� Select several threads and click the Edit Selected button to add a note in the Edit 

Selected dialog. See “Edit Selected” on page 33.

Edit Selected
Use the Edit Selected dialog to edit the notes and spool information for the 
selected threads.

� Select one or more threads and click the Edit Selected button to open the Edit 
Selected dialog. Click OK to save your changes.

Spools
Set the number of spools you have of the selected threads.

� Select (check) the "Set number of spools to all selected" checkbox, then enter the 
number of spools in the number box.

Spool Size
Set the length of the thread on the spool. Choose from 225, 250, 1000, 1100 and 
5000, and set the measurement units as meters or yards.

Note: Set the default spool size and measurement units in the Preferences dialog. 
See “Preferences” on page 47.

Number of spools for the selected threads

Spool length for the selected threads

Enter notes for the selected threads
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� Select (check) the "Set spool size to all selected" checkbox, then choose a thread 
length from the pop-up menu. You can also change the measument units in the 
second pop-up menu.

Notes
Add notes for the selected threads, for example the number of spools needed.

� Select (check) the "Set notes to all selected" checkbox, then enter the desired text 
in the Notes text box.
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Print
Use the Print dialog to select your print settings, and to print a list of threads for 
the selected My Thread database.

Select Show Details to choose the My Thread Database and the information to be 
printed with the thread list, set the sort order, and select the printer and page 
layout. Then print the thread list.

To open the Print dialog

� In the My Thread Stock window, click Print .
� Choose File > Print
� Press ⌘P

Preview
Display the thread list as it would appear when printed.

If there are multiple pages, step through them with Next Page  and Previous 
Page .

PREMIER+ 2 Thread Cache
Print: Print either the full database list, or only the Star threads. See “Star” on 
page 32.

� Select My Thread Database to print the full database, or Star Threads to print 
details for only the highlighted threads.

Sort By: Sort the threads as Arranged in the list, or sort by Star, Number, Name, 
Type, Weight, Spools, Size or Notes. Use ascending or descending order.

� Choose a sort type from the pop-up menu, then choose ascending or descending 
order.

My Thread Database: Select the personal thread database to print.
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� Choose a My Thread database from the pop-up menu.

PDF
Choose PDF creation settings.

Hide Details
View a concise version of the Print dialog.

Printer
Select the printer you want to use.

Presets
Choose a saved printer setup.

Copies
Select the number of Copies you wish to print, and whether to print on two sides.

Pages
Select the range of pages you wish to print.

Paper Size
Select the size of paper that the thread list is to be printed on.

Orientation
Choose Portrait or Landscape.

Settings Menu
Select the settings details for the following from the pop-up menu under the app 
name:

• Layout
• Color Matching
• Paper Handling
• Paper Feed
• Cover Page
• Supply Levels

Layout
Choose the number of pages per sheet, whether to use a border, and whether to 
print on two sides, reverse the page orientation, and flip horizontally.

Color Matching
Select the color match profile.

Paper Handling
Select page order, whether to collate pages, which pages to print, and scale relative 
to paper size.
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Paper Feed
Select your paper source.

Cloud Connection
Use the Cloud Connection dialog to upload your My Thread database to the 
Software Registration Database.

To open the Cloud Connection dialog

� In the My Thread Stock window, click Upload .
� Choose File > Upload
� Press ⌘U

Upload a My Thread Database to the Cloud
1 In PREMIER+™ 2 Thread Cache click the My Thread Stock button.
2 Choose the desired My Thread database in the My Thread Database pop-up menu.
3 Click the Upload button . The Cloud Connection dialog appears.
4 Enter the e-mail address for your Software Registration Database account in the text box, 

or sign in using your Facebook® , Twitter®  or Google+®  social media account.
5 Enter the password for your Software Registration Database account in the Password text 

box.
6 Select (check) the Remember Password checkbox to save your password for the next time 

you sign in.
Note: Do not select this option if you are using a shared computer.

7 Click OK to upload the My Thread database to the Software Registration Database.
Note: If that My Thread database was previously uploaded, the old version will be 
overwritten. Any thread Purchase information is removed.



PREMIER+™ 2 Thread Cache   The Thread Cache Website              39

6The Thread Cache Website

Transfer your thread database from your Mac to the Thread Cache 
web database to view on mobile phone or tablet. Use the Thread 
Cache website to view your chosen threads, and note your 
purchases as you visit different stores.

Use the Thread Cache website on your mobile device to view and update your My 
Thread databases. View all threads, or Star threads, and note which threads you 
have purchased.

Note: The Thread Cache website can be used on most mobile devices.

To learn how to Go to

Open the Thread Cache website on your 
phone or tablet

See “Open the Thread Cache Website on 
your Phone or Tablet” on page 40.

Update a My Thread database See “Update your My Thread Database” on 
page 41.

Choose a different My Thread database See “Choose a Different My Thread 
Database” on page 43.

Mark a thread as purchased See “Set a Thread to Purchased” on page 45.

Set the sort order for the threads See “Choose a Sort Order for the Thread 
Database” on page 44.

Enter your Cloud Connection details to download threads 

Select a different My Thread database, or your Star Threads

Search or change the sort order for your threads

Click to view the details for this thread

Summary thread information

Star threads

Current My Thread database
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View Your Threads on Your Mobile Device
Enter your Cloud Connection details to view your thread databases on your 
mobile device.

Open the Thread Cache Website on your Phone or Tablet
1 Open the web browser on your phone or tablet.
2 Browse to ThreadCache.PremierPlusEmbroidery.com.
3 Tap the Download Threads button . The Cloud 

Connection Settings window is displayed.
4 Enter the e-mail address and password for your Software 

Registration Database account, or sign in using your 
Facebook® , Twitter®  and Google+®  social 
media account.

5 Tap Download My Thread Databases.
The thread databases that you uploaded to the Software 
Registration Database are downloaded to your mobile 
device. See “Upload a My Thread Database to the Cloud” 
on page 37.

Using Thread Cache website on your mobile
Use the Thread Cache website to view the threads in your My Thread databases 
on your mobile device.

View the details for a thread See “Details” on page 45 and “Select a 
Thread” on page 41.

Select and view your Star Threads See “Display your Star Threads” on page 43.

To learn how to Go to

Enter your Cloud Connection details to download threads 

Select a different My Thread database, or your Star Threads

Search or change the sort order for your threads

Click to view the details for this thread

Summary thread information

Star threads

Current My Thread database
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� On a phone or other narrow screen device, tap to view the details for a thread.

� On a tablet or other wide screen device, the details for the selected thread are 
displayed.

Select a Thread
1 On your mobile device, open the Thread Cache website: 

ThreadCache.PremierPlusEmbroidery.com
2 In the main window, tap the desired thread.

On a tablet the thread details are displayed in the pane on the right. On a phone the thread 
details are displayed on a separate page.
See “Details” on page 45.

Update your My Thread Database
1 On your mobile device, open the Thread Cache website: 

ThreadCache.PremierPlusEmbroidery.com
2 Tap Download Threads .
3 In Cloud Connection Settings, enter the e-mail address and password for your Software 

Registration Database account.

Note: Alternatively, sign in using your Facebook® , Twitter®  and Google+®  social 
media account. 

4 Tap Download My Thread Databases. Your updated thread databases are downloaded.
5 Tap My Threads to return to the main screen.

View the details for the selected thread
Enter your Cloud Connection details

Current My Thread database
Select another database, or Star threads

Search or change the sort order 

Summary thread information

Star thread

Star and purchased thread

Select a thread to view its details

for your threads
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Settings
Download updated thread databases from the Cloud 
Connection Settings window.

• Enter the e-mail address and password for your 
Software Registration Database account. 
Note: Alternatively, sign in using your Facebook® , 
Twitter®  and Google+®  social media account. 

• Tap View My Thread Databases.

Display
In the Display pop-up menu, choose a My Thread database, or Star Threads.

Note: Star Threads selects only threads that you highlighted with a star in 
PREMIER+™ 2 Thread Cache. 

Choose a Different My Thread Database
Use the My Threads database pop-up menu to select a My Thread database or Star 
Theads.

1 On your mobile device, open the Thread Cache website: 
threadcache.premierplusembroidery.com

2 In the main window, select a My Thread database from the pop-up menu, or choose Star 
Threads to view only your star threads.

Phone Tablet
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Display your Star Threads
1 Highlight the desired threads with a star in PREMIER+™ 2 Thread 

Cache. See “Viewing and Sorting Threads in a My Thread 
Database” on page 31 and “Star” on page 32.

2 Upload your updated My Thread database to the Software 
Registration Database. See “Upload a My Thread Database to the 
Cloud” on page 37.

3 Update your My Thread databases on your mobile device. See 
“Update your My Thread Database” on page 41.

4 On your mobile device, open the Thread Cache website: 
threadcache.premierplusembroidery.com

5 In the main window, select Star Threads in the My Threads 
database pop-up menu.
The Star Threads in your My Threads databases are displayed.

Sort By
Set the sort order for your threads.

Choose a Sort Order for the Thread Database
1 On your mobile device, open the Thread Cache website: 

ThreadCache.PremierPlusEmbroidery.com
2 In the main window, tap Search .
3 Select a Sort Order from the Sort By pop-up menu.
4 Tap Ascending  or Descending  to select the threads 

shown at the top of the sort order.
5 In Search enter part of the name or code for a thread to 

search for it by name or number. For example, ’bl’ will search 
for blue and black threads.

6 Tap Search  again to close the Search and Sort area.

Order
Set Ascending  or Descending  to show your sorted list in ascending or 
descending order.

Arranged
Use the order that you set for the My Thread database in PREMIER+™ 2 Thread 
Cache on your Mac. See “Change the Order of a My Thread Database” on 
page 23.

Purchased
Sort by the threads tagged as Purchased. See “Set a Thread to Purchased” on 
page 45.
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Star
Sort by the threads highlighted with a star. See “Star” on page 32.

Number
Sort by the thread number. See “Thread Number” on page 19.

Name
Sort by the thread name. See “Thread Name” on page 19.

Type
Sort by the fiber used for the thread. See “Thread Type” on page 19.

Weight
Sort by the thread weight. See “Thread Weight” on page 19.

Spools
Sort by the number of spools of the thread. See “Spools” on page 33.

Notes
Sort by the text in the Notes field for the thread. See “Notes” on page 33.

Details
The details for the selected thread show the thread information (range, number, 
name, type and weight), whether it is starred, any notes, and a preview using the 
thread. Set the thread to Purchased when you have added to your stock.

Note: Information on Purchased threads is not preserved when the My Thread 
database is next updated.

Phone Tablet
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View the details for a thread
� On a tablet, tap to highlight a thread. The thread details are displayed in the pane 

on the right.
� On a phone, tap the thread name to view the Thread window.

Set a Thread to Purchased
1 On your mobile device, open the Thread Cache website: 

ThreadCache.PremierPlusEmbroidery.com
2 In the main window, tap to select a thread.
3 In the Thread pane, tap Purchased to select the Purchased button. In the My Threads 

window, the thread is now marked with a P.
4 When you are back at your Mac, update the thread spool information in your My Thread 

databases in PREMIER+™ 2 Thread Cache.
Note: Information on Purchased threads is not preserved when a My Thread database is next 
updated on your mobile device.
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7Preferences

Use Preferences to set the default spool size for your threads, and 
choose the measurement units for display.

Use Preferences to set the default spool size for yout threads, and to choose which 
measurement units to use. When default spool size is changed, the new settings 
are remembered when PREMIER+™ 2 Thread Cache is closed and reopened.

To open Preferences
� Choose PREMIER+™ 2 Thread Cache > Preferences.
� Press ⌘,

Default Spool Size
Choose the default thread spool size size from 225, 250, 1000, 1100 or 5000 
meters or yards. The initial setting is 1,000 meters.

� Choose the Default Spool Size from the pop-up menu.

Measurement Units
Use meters or yards for the thread length measurement.

� Choose yards or meters from the pop-up menu.
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8Troubleshooting

Error Messages
Opening and Using PREMIER+™ 2 Embroidery System Apps

"Feature not available in this version."
This message will appear when trying to start a module or feature if the 
PREMIER+™ 2 Embroidery System cannot detect an activation for that module or 
feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or 
look in the Purchase Center at: www.EmbroideryPurchaseCenter.com

Using PREMIER+™ 2 Thread Cache

"This action is permanent and may not be reversed. Do you wish to 
continue?"
This message appears if you try to delete a thread definition from a My Thread 
database, or to delete a My Thread database. If you wish to go ahead and delete 
the thread, click Yes. Otherwise click No.

"The thread XX already exists in the selected Thread Database. Do you 
want to overwrite it?"
This message appears if you try to use an existing thread name in a My Thread 
database. If you wish to overwrite a single thread name, click Yes, otherwise click 
No. If multiple threads are selected, to overwrite the names click All, otherwise 
click None.

Uploading to the Cloud

"Failed to connect to the Cloud: The e-mail address has been recognized 
but the password is incorrect"
No connection can be made with the software registration database. A correct e-
mail address has been used with an incorrect password. Check the e-mail address 
and password, and try again.

"Failed to connect to the Cloud: An error has occurred. Please try again."
No connection can be made with the software registration database. An unknown 
e-mail address was used. Check the e-mail address and password, and try again.
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"Failed to connect to the Cloud: The e-mail address is incorrectly 
formatted."
No connection can be made with the software registration database. The e-mail 
used is not a valid e-mail address. Check the e-mail address and password, and try 
again.

Miscellaneous

"Not enough memory available to perform function."
This message appears if system resources are low. Close other programs and try 
again. If this does not work, try restarting your computer.

Other Topics
General Use of My Threads

Colors in PREMIER+™ 2 Embroidery System Files
The PREMIER+™ 2 Embroidery System displays threads in a file in the same way 
on any computer where it is installed. That is, the colors used are the same even if 
they are reproduced slightly differently on different monitors. You can print a 
worksheet to see the colors and color names used in a particular design. This is 
true, even if you do not have all the threads in a design defined in the Standard or 
My Thread databases on your computer. This is because a PREMIER+™ 2 
Embroidery System design has complete information for each of the threads it 
uses.

Any of the following file types is a 'design' that has full PREMIER+™ 2 Embroidery 
System thread definitions:

• Husqvarna Viking/Pfaff .vp4 or .vp3 embroidery file
• PREMIER+™ 2 Create .edo design outline file
• Font .mft file

Note: Only Husqvarna Viking/Pfaff .vp4 or .vp3 embroidery files can be used to 
import custom thread definitions into a My Thread database.

Each thread used in a design falls into one of the following categories:

� A thread you have added to a My Thread database from the Standard Thread 
Database and which you have not changed. This will apply to most of your colors if 
you have used a My Thread database to catalogue your thread collection.

� A thread from the Standard Thread Database.
� A thread which you formerly added to a My Thread database from the Standard 

Thread Database, used in some designs and then deleted from the My Thread 
database.
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� A custom thread that has been added to a My Thread database. You could have 
added this yourself or added it to  a My Thread database from a design from 
somebody else.

� A thread from the Standard Thread Database that is not on your own Standard 
Thread Database because your database is out of date.

� A custom thread defined in the file that does not appear in the your My Thread 
database.

The availability of threads in the Standard Thread Database and My Thread 
databases will only affect parts of the PREMIER+™ 2 Embroidery System where 
you can change colors. For example:

� Editing apps: PREMIER+™ 2 Embroidery and PREMIER+™ 2 Modify
� Design apps: PREMIER+™ 2 Create, PREMIER+™ 2 QuickFont

Below are some situations you may encounter according to the availability of 
thread definitions, as categorized above.

"I have a vp4 or vp3 embroidery from another user that uses a custom 
thread definition they designed in a My Thread database."
If you attempt to change the color, a message appears to indicate that the thread is 
not found in My Threads, and the nearest My Threads match is selected. Use 
Import Threads from Embroidery to import the custom threads, or select a 
replacement thread.

"I have a design with My Thread colors that are unmodified copies from the 
Standard Thread Database, but they are not in my My Thread database."
If you open a file that has colors from a My Thread database that are unmodified 
copies of standard threads, but do not exist as copies in your My Thread database, 
the color is identified and selected in the original thread range when you click the 
color to change it.

"I have a design with custom colors that have been deleted from My Thread 
database."
If you attempt to change the color, a message appears to indicate that the thread is 
not found in your My Thread database, and the nearest My Thread match is 
selected. Select a replacement thread.

"I have a design from another user that uses threads from the Standard 
Thread Database that I do not have."
Use Smart Update to find and download the latest thread database, which you can 
then install.

"How do I add Color Effects to my thread stash?"
Color Effects cannot be added in PREMIER+™ 2 Thread Cache. Add Color Effects 
to selected threads within a design using the Color Selection dialog of 
PREMIER+™ 2 Embroidery System modules.
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Registration

"How do I change my personal information for my software registration?"
Simply click the Register button in PREMIER+™ 2 Configure and repeat the 
registration process. This does not change the registration status of software you 
have already registered, but it does allow you to change your personal information 
and/or dealer information.

If you are not at the computer with PREMIER+™ 2 Embroidery, you can enter 
your e-mail address and password to find your registration details.
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